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Welcome
Dear Customer,
On behalf of Bio-Rad Laboratories and ARRM Bio-Tech Ltd., we would like to thank you for investing in the PROTEAN 2-D Spot Cutter System. This product was produced in collaboration between
Bio-Rad and ARRM Bio-Tech Ltd.
One of the best ways to familiarize yourself with the capabilites of your new PROTEAN 2-D Spot
Cutter System is to read this manual. In it, you will learn how to set up the system and operate all
hardware and software components. After reading this manual, please keep it close to your system
so that it can be conveniently referred to.
Your PROTEAN 2-D Spot Cutter System is protected by a comprehensive instrument warranty
agreement. Please read this manual thoroughly, so that you fully understand the coverage provided
and are aware of your rights and responsibilities. One of the responsibilities of system ownership is
regular maintenance. Following the maintenance instructions provided with this manual will help
to keep your system functioning optimally and will protect your investment. Please also keep in
mind that Bio-Rad offers a range of comprehensive service agreements that can be tailored to meet
your specific needs.
Bio-Rad Laboratories is dedicated to your total satisfaction and would be pleased to answer any
questions or concerns that you may have.
How to Contact Bio-Rad Laboratories
In the United States you can reach Bio-Rad Laboratories at the following numbers:
For general information
Toll free:
1-800-4BIORAD
1-800-424-6723
Fax:
1-510-741-5802
email:
lsg.techserv.us@bio-rad.com
For service or technical assistance
Toll free:
1-800-424-6723
Fax:
1-510-741-5802
For information concerning Bio-Rad Laboratories and its products, visit our Worldwide Web site
at http://www.bio-rad.com.
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Section 1
Introduction
1.1 General Description
The PROTEAN 2-D Spot Cutter System is a precision piece of equipment for the
accurate location, excision and loading into micrometer plates (MTP) of protein spots after
separation on 2-D electrophoresis gels or PVDF membranes. The system has been designed
to be both robust in construction and simple to operate.

1.2 Operation
Before using the system, please take a few minutes to read this manual. As delivered, the
minimum requirement is to plug in the computer, load in the software and related peripherals
and turn on the system, as instructed in this manual.

1.3 Caution
It is detrimental to the system to leave the lighting on for more than 10 minutes at a time
as it may lead to permanent damage of sections of the system.

1.4 Moving The Spot Cutter
The System should be moved:
•
•
•

In the upright position.
By lifting and carrying from the base.
By placing down in the upright position on a stable surface.

Important Note: The system must not be moved by lifting the system up by the camera arm.

1.5 Computer Recommendations
Processor:

300 MMX or greater
2.1G Hard Drive or greater
RAM:
64 Mb or greater
Screen Resolution:
1024 x 768
Communication ports: 2 serial ports are required
2 Mb Video RAM
Operating system:
Windows 95, 98, or NT

1.6 Cutting Excision Sizes
Tip Size:

Inside Diameter is 1 mm
Outside Diameter is 1.5 mm
Maximum cutting area:
11.8 x 8.8 cm
Gel Sizers and Frames provided: Large Gel Sizer
Mini Gel Size:

11.8 x 8.8 cm
9.5 x 7 cm

1.7 Power Setting
Power can either be 120 V or 240 V (50 Hz/60 Hz)
Verify that you are using the correct power voltage by inspecting the voltage setting
indicator and the rating on the fuse installed in the system. (see Appendix C)
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Section 2
Getting Started
2.1 Preliminary Instructions
1. Undo the two "L" Shaped brackets from the Systems X-Y Movement Bar (see Appendix A).
2. Undo the other "L" bracket from the back of the cutting head assembly.
3. Remove the electrical tape from the cutting tip.
4. Undo the zip tie from the back of the system.
5. Check that the voltage is set to the appropriate settings (see Appendix C). Regional operating
and voltage requirements should be noted. The system voltage is turned from 120 V to 240 V
with a small screwdriver turning the voltage indicator. The appropriate fuse must be used,
the back panel has the fuse listings for the voltages. Both the main power and the voltage
fuses should be checked with a fuse meter before operation to ensure the fuses are in
working order.

2.2 Connector Cables
The software for this System has been programmed for x-y system movement
communication on COM 2. The 25-pin male connector to 9-pin female connector cable is for
the system to computer communication. The 25-pin connector is connected to the female
connection on the system communications interface plate located at the rear of the system base
box, see Appendix C. The 9-pin connector should be connected to COM 2 port.
The 9-pin female connector to round connector cable is for communication to camera. The
9-pin connector connects to a 9-pin COM port of the computer, and the round connector to the
camera COM port of the camera communications interface plate located at the rear of the
camera mounting arm. (see Appendix C.)
The camera power cord connects into the camera interface plate directly below the
camera communications plug. (Refer to Appendix C)
The main power cord connects to the main power socket of the system (see Appendix C.)
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2.3 Software Setup
Use the following steps to load the SpotOn software and the image acquisition software
onto the computer.
1. Create a folder in the C: drive with the name Spot Cut. The spot cutter will look for the
folder with this name to get its instructions for movement and orientation.
2. The SpotOn software and the offset file that contains calibration information are loaded
into the Spot Cut folder.

3. The Kodak image acquisition software is loaded into the Program File folder of the
computer. The Kodak software will self install in the Program Files folder.

2.4 Initial System Set Up
After connecting the system to the computer and loading the software, the system is ready
for use. The first step will be to calibrate the x-y axis of the spot cutter to the image that is
acquired by the camera. See Section 6 for calibration method.

2.5 Quick Guide to Spot Excision
The following is a quick guide to the operation of the spot cutter system. Details on individual
steps and features are covered in the following sections of this manual.
1. Turn on the computer.
2. Turn on the Protean 2-D Spot Cutter System.
3. Double click on the SpotOn icon (the SpotOn Cutting System menu should now be
displayed.)
4. The system must be reset to its home. This is done by pressing the start/pause button located
on the system front panel. (See Appendix A) The excision head will now be homed to the
back right corner of the system.
5. Load a liquid into each well of the microtiter plate. Water or other liquid helps with gel
deposit, and it prepares the gel spot for downstream processing without drying out.
6. Place microtiter plate in position (refer to Section 5.4)
7. Place the cutting mat into the cutting stage area.
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8. Cut the gel to the appropriate size with the cutting tool and place in the gel frame. For PVDF
membrane, use the gel frame to center the membrane on the cutting stage.
9. Acquire an image of the target gel or membrane. See Section 3 for image acquisition
instructions.
10. Once back in the SpotOn Cutting System program, open the image that was just acquired.
11. Select spots for cutting. Use the left mouse button to bring up the Zoom box, and use the right
mouse button to select a position for cutting.
12. After you have selected the spots to be excised, start the cutting run.

Section 3
How To Use Photo Enhancer and the Digital Camera
This section covers the steps for taking an image and saving the image file using the
Photo Enhancer program. More specific instructions on using Photo Enhancer such as editing
an image, are found in the "DC120 Zoom Digital Camera User's Guide" supplied with this
manual.

3.1 Turning on the Digital Camera
The camera is turned on by opening the camera cover slide located at the bottom left
hand corner of the camera. The cover is moved to the left to turn the camera on and to the right
to turn the camera off.
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3.2 Selecting the DC120 Digital Access (TWAIN Acquire)
Window
In order to activate the lights, go to the menu item "Operation" in the SpotOn software.
Choose, "Others". Check the "Light Select Enabled" option (a check mark shows up in the box
next to the item). This allows the software to turn on the lights by the menu bar icon or
during the process of setting up to take a picture.
Select File from the menu bar to display a drop down menu. Select Photo Enhancer.
Alternatively, press the Photo Enhancer shortcut button located below the menu bar. (see
Appendix D)
An information box will be displayed. Selecting "Yes" will move the system to parking
position and switch the lights on. Selecting "No" will transfer to the image acquisition software
without turning on the lights. This may be advantageous as you can turn on the lights with the
red "pulse" button on the front of the instrument when taking a picture. Especially when an
image is going to be optimized with the software, it is better to select NO to the lights, and turn
them on with the pulse switch. Press and hold the pulse switch during the image acquisition
process.
Important Note: do not leave the system lights on for extended periods of time. Leaving the
lights on for more than 10 minutes may cause permanent damage to occur to sections of
the system.
Another information box will be displayed providing instructions for use. Acknowledge
by clicking on the OK button.
Select the File menu from the menu bar. Click on TWAIN Acquire or use shortcut key
Ctrl+W. This will display the DC120 Digital Access (TWAIN Acquire) window.

3.3 Camera Functions
Once the DC120 Digital Access (TWAIN Acquire) window is displayed, click on the
"Camera Functions" button to select camera settings. This will produce the Status LCD
Function Set Up folder which contains the Focus and Flash settings.
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In the Auto Focus panel, select Macro Mode. This will disable the auto focus on the
camera. The AutoFocus is not recommended because it adjusts the focal length to each new
image and changes the image area from that which was calibrated.
Suggested Flash settings:
For gels, turn the flash setting OFF.
For PVDF membrane and calibration templates, use FILL flash. The under lighting may or
may not be needed for a FILL FLASH picture. The underlighting can be turned on and off
through the SpotOn software. Adjustments to these guidelines may be made depending on
ambient light conditions in the lab. No light may be needed in some cases.
In the Quality panel, select Better.
The "Update Camera" button in the Status LCD Function Set Up folder must be clicked
to confirm your new selections. The software will hold the settings during multiple images in
a normal workflow. The settings will need to be reset if the computer, camera, and spot
cutter system are restarted.

3.4 Acquiring an Image
An image can now be acquired by clicking on the button labeled Take a Picture. Once
the image has been taken, a small picture is displayed in the top right hand corner of the
TWAIN ACQUIRE window. Once the image is acquired, the image can be enhanced for
overhead lighting conditions by selecting the Enhance icon, and selecting Fluorescent.
Evaluate the effects in the thumbnail picture, if the picture is worse, select Auto Lighting
(Default) to change back to the original image.
Select the Transfer Picture button. The image is now being transferred to the Photo
Enhancer screen. More enhancement functions are available in this screen. If more enhancement
is needed and some time is going to be spent on this function, go back to the SpotOn software
and select Turn Lights Off. This will allow work to be done without damage to the spot cutter
or excessive drying out of the gel.
Now the image may be edited as required. The most useful menu is Enhance. Choose the
Enhance by Example option. This will produce this screen:

.
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In the small, full image in the upper right hand corner of this screen, move the blue box
within the small image to an area that needs the most enhancement. Use the 3x3 example
boxes to choose the best image for "Exposure" and "Brightness/Contrast". Choose Apply to
set the new parameters to the entire image. When satisfied with the image enhancement,
choose Done.

3.5 Saving an Image
To save the image, select File, Save As. The file must be saved as a Bit Map picture format.
Click on the button in the Save File as Type list box. This displays a drop down list from
which a (*.bmp) file should be selected. Select the directory and folder you want to save the
image in. This should be on your C: drive as it needs to be accessible to the SpotOn software.
To select file name, click on the File Name text field, then the file name can be typed in.
Make sure the name has a .bmp extension on the file name. Click on the "OK" button to save
the image. Once the image has been saved, exit the Photo Enhancer software. This will return
back to the SpotOn software that was running in the background.

3.6 Erasing Picture Memory
The DC120 camera has a memory chip that holds pictures as they are acquired. These files
need to be periodically deleted from the camera. Erasing these pictures does not effect the
saved images on the computer. The camera memory holds about 20 images.
To delete pictures, go to the Camera Functions screen and select the "Erase Pictures"
option. This will bring up a screen with the file names of the pictures existing in the camera
memory. Select the pictures to be deleted (usually all) by clicking on the first file name, hold
the shift key, and click on the last file name. All the files should now be highlighted. Select
"Add to List" which will produce a list in the right hand box of all the files that will be erased.
Click "OK" to erase. A confirmation box will come up, click "OK". A processing bar will
appear showing the status of the deleting files. The process will take ~5 minutes to delete 20
files. When it is finished, click on "Close" to return to the Camera Functions box.

Section 4
Selecting and Cutting Spots
4.1 Opening an Image File Format
To open an image file in the Spot On screen, select File; Open Image File.
Alternatively, this may be done by clicking on the Open Image File shortcut button located
below the menu bar. (see Appendix D)
This will generate the Open window, which will display a list of files. Select the
appropriate folder and open the image by either a double left mouse click on the file name, or
a single left click on the file name followed by a click on the "Open" button.
The new project number window will be displayed. To move between text fields and
enable typing of text, you must click on the required text field. Entering a project number and
Gel/PVDF number is optional.

4.2 Using the Zoom Window
Left clicking on any position on the gel image will display the selected area in the zoom
window at the top right hand corner of the screen. The position's x-y pixel coordinates will be
displayed below this zoom window.
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The zoom setting of the window can also be adjusted by using the + or - zoom setting
shortcut buttons. (Refer to Section 7.2 for details.) The zoom window allows for a choice of
whether selected spot numbers are displayed in the zoom window or not by selecting View;
Display with spot No.

4.3 Selecting a Spot & MTP Location
A right mouse click on any position will select the spot at the cursor crosshair to be cut,
and produce a pop-up menu with the following choices;
a)

Select to next MTP well: This will allocate the selected spot to be deposited in the
MTP location immediately following the MTP position of the previous spot
selected i.e. A2 after A1, B1 after A12 etc. If the spot is the first spot selected for the
image file it will be allocated to A1.

b)

Select to other MTP well: This choice will display the MTP Location window. Any
location can be selected for a particular spot, by
(i) Selecting the MTP position text field, then typing in desired location, or
(ii) Selecting the MTP position button (which will display a drop down list), then
clicking on the desired location. The Scroll Bar may be used to move throughout
the list. If you do not want to select this spot simply select the "Cancel" button. To
confirm a spot you now click on the "Select" button.

A maximum of ten spots can be allocated to any one MTP position well.
The MTP well positioning layout scheme is detailed in Section 5.4.
Once selected, the spot will appear as a red circle containing a spot number.

4.4 Deleting Spots
Once a spot has been selected and allocated to a MTP well position, it may be deleted by
either of the following methods;
(i)

Move the dotted line box within the MTP grid to the box containing the spot to be
deleted by using the arrow keys on the keyboard. Right click on the MTP spot
destination window located at the bottom right-hand corner of the screen. This will
produce a pop-up menu, from which you should select Delete this spot.

(ii) Select the Window menu from the menu bar then Spot Location from the drop
down menu. The Spot Location window will now be displayed. Right click in the
Current State column for the corresponding row of the spot number you wish to
delete. This will produce a pop-up menu from which you click on delete to remove
the spot. Alternatively, if a selected spot has been cancelled, you may follow the
above steps but click on Select from the pop-up menu instead of Delete. Once the
alteration has been made, click on the OK button on the spot location window to
proceed.
(iii) Select the View menu from the menu bar, then Delete Spot from the drop down
menu. The Delete Spot window will now be displayed. Click on the spot number to
be deleted in the larger text field. This spot number should now be displayed in the
smaller text field. The spot can now be deleted by pressing the OK button. If you wish
to leave the Delete Spot window without deleting a spot, simply click the Cancel
button.
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4.5 Making Cuts (Excisions)
Select the appropriate cutting tip action from the Operation menu, Others. A description
of the options is provided in Section 8.4.
Hint: For best deposit of gels and membrane spots, add 150–175 µl of liquid (water,
acetonitrile, etc.) to each microtiter plate well. This will provide the best condition to
deposit spots effectively, and it will keep the spots from drying out in the microtiter wells.
Recommendations for cutting tip actions:
Acrylamide Gels:

Use standard (default) method. For increased assurance of positive eject,
select Double Eject.

PVDF Membrane:

Use Eject With Turn in order to help eject the static membrane from
the stainless steel tip.

Calibration:

Use Cut without Turn in order to keep the cutting tip from marking the
template.

A cutting run can be selected by either(i)

Selecting the Run shortcut button located below the menu bar.

(ii) Selecting the Cutting menu, then selecting Run from the drop down menu.
You may not wish to cut all the spots selected during this cutting run. This can be achieved
by putting the desired starting spot number and last spot number in the "Start from" and "To"
fields of the Set-up Cut Spot window.
Note: An individual run must consist of a sequential subset of the total spots selected, i.e.
you can not select to cut spots 4 & 6 on an individual run without spot 5 being cut. An
individual cutting run cannot be out of order, ie. 4, 6, 5 is invalid, it would need to be 4, 5, 6.
Once the spot sequence to be cut has been selected, press the OK button of the Setup Cut
Spot window.
When cutting is complete, the Cutting Complete box will be displayed, select OK to
continue. It is advisable to check the completeness of the cutting run by visually verifying
that each well has a gel spot in it. If there are any missing wells, it is likely that the gel spot
is still in the gel. The cutter can very easily be directed to re-cut these spots. See next section
on Cut Previous Spot methods.

4.6 Re-Cut Previous Spot
If there is the need to re-cut a previously selected spot, there are several ways to direct the
spot cutter to re-cut a spot.
a. The MTP grid area of the screen can be used to easily re-select the few spots that may not
have been picked up from the gel. Move the dotted line box within the MTP grid to the
box containing the spot to be deleted by using the arrow keys on the keyboard.(You may
need to right click on the table to produce the dotted line bos. Hit escape, then move the
box with the arrow keys.) Right click on the MTP spot destination window located at the
bottom right-hand corner of the screen. From the pop-up menu select Single Cut. The
cutting arm will go to that spot location, perform the cut, and return to the appropriate
MTP well location. This can be repeated for other individual spots to be re-cut.
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b. Select the Window menu, then Spot Location from the drop down menu. This will
produce the Spots Location window, which displays details of all selected, deleted, and
cut spots. The Current State of the particular spot may be changed from Cut to Select
by right mouse clicking in the Current State column for the spot to be re-cut. This will
produce a pop-up menu, select Delete. Right mouse click on the Current State column,
choose Select which will change the spot back to the select state enabling it to be re-cut.
This may be done for any number of spots. Once completed the spot may be cut using the
same method as for any individual cutting run.
c. Select the Run shortcut button, or choose Cutting; Run. Use the Cut Previous Spot
selection which is found within the Set-up Cut Spot window. Cut Previous Spot is
activated when a check appears in the check box. Enter the spot numbers to be re-cut.
They must be in sequential order to be a valid cutting order, or one spot can be entered at
a time.
Except for the case when several spots will be re-cut in sequence, the first re-cut method
in this section should be used.
Auto Cut Previous Spot/Enabled
(a) With Select Previous Spot enabled, if any previously cut spots are selected in
the run to be cut, once "OK" has been pushed to commence the cutting run, and
information box will be displayed individually in turn for each previously cut
spot. In this box you may either select the "Yes" button to re-cut the spot or
"No" button not to.
(b) With Select Previous Spots disabled, selecting the "OK" button enables the
operator to repeat the previous cut run. Additional spots can be selected and on
clicking the "OK" button all previous selections, plus the additional spots will
be cut.
Once all previously cut spots have been addressed, the program will automatically cut
any new spots in the run.
This function allows for any combination of previously cut spots to be cut, ie. you may
cut spots 1,3,5 without cutting 2 & 4, even though 2 & 4 are within the range of the selected
spots to be cut (excised).
Auto Cut Previous Spots Disabled
With this function disabled, no previously cut spots will be re-cut.

Section 5
Working Surface
The working surface is shown in Appendix B and consists of two main areas, the cutting
surface and the microtiter plate holder. In addition there is also a bubble level which may be used
to ensure the cutting surface is level.

5.1 Excision Mats
The gel or membrane is cut on a custom designed PVC excision mat. Only use 1 mat for
correct height.
Two PVC (Clear) excision mats are provided with the system. These mats may become
scored by the cutting tip, stained by the gel stains, or become cracked with repeated use over
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time. This is normal wear and replacement mats are available from Bio-Rad. Order catalog
number 165-7021.

5.2 Cutting Surface
Gels and membranes should be cut on the excision mat to provide the correct backing
for the excision tip. The overall surface dimensions are 178mm x 180mm, however, the
recommended excision area size is 11.8 x 8.8 cm due to the area that can be imaged with the
camera. Clean the cutting surface regularly with mild detergent and water. Clean water off the
cutting platform and the base after use.

5.3 Gel Sizer and Frames for 2-D Gels
In order to facilitate cutting a larger gel down to the size that can be imaged on the spot
cutter, two sizes of gel sizers and holding frames are provided with the system: a 11.8 x 8.8 cm
Large Gel "quadrant size, and a 9.5 x 7 cm mini gel size.

5.4 Microtiter Plate (MTP) Holder
The MTP holder is to the immediate right of the cutting surface. To insert a microtiter plate
(MTP) into the holder, hold the plate at a slight angle, push the corner of the microtiter plate
corresponding to position H12 against the positioning pin located at the bottom left hand
corner of the MTP holder. Once the positioning pin has been pushed in slightly, the microtiter
plate can be pushed down into the holder. The positioning pin is spring loaded and will hold
the plate in place.
As viewed on the surface of the Spot cutter the software allocates the microtiter plate
well positions as follows -

The system accepts any standard microtiter plate. Polypropylene plates are recommended
for protein processing. Corning and Grainer brand plates have been tested and work well in
this system. Use "U" or "V" well bottoms for best recovery.
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Section 6
Calibration
6.1 Camera Alignment
If the cutting head is not moving to the correct position as selected using the software, the
system should be calibrated. To assess the alignment of the camera to the cutting stage,
perform the follow steps using the calibration plate (the plastic plate with a rectangle):
1. Place the calibration plate on the cutting surface.
2. Take a photo of the calibration plate.
3. Save the photo.
4. Open the photo within the SpotOn program.
If the image of the calibration plate is not square, i.e. it appears to be generally shaped like
any of the following pictures, a-d, the camera is out of alignment and requires Bio-Rad Service
to arrange a service visit to align the camera.

a.

b.

c.

d.

If the rectangle is at right angles in the viewing screen and is accurate in its shape, but the
system is not moving to the correct x,y position, then proceed with the following calibration
routine. A copy of the System Serial Number is necessary for calibration and has been
supplied upon delivery of the system.

6.2 Calibration Definitions
Pixel Position Y (PPY) & Pixel Position X (PPX): the scale/ratio between the image on
the screen and the image in real life.
X and Y Offset: adjusts the distance between the position that the system actually moves
to, and the position that the system should have moved to. Scale: 100 units in the numbering
of X and Y Offset is equal to 1mm on the calibration plate. A four digit number is entered for
both the X and Y offset values. For every 100 digits, the system is offset 1 mm on the cutting
surface.

6.3 Calibation Procedure
1. Place the calibration plate or graph paper on the cutting surface
2. Take an image of the calibration plate or graph paper
3. Save the image
4. Open the image within the SpotOn software
5. In the Operations menu, select Others. A dialog box will appear and select Cut Without
Turn. This will allow the cutting tip to go to the selected spot without cutting or
marking the calibration template or graph paper.
6. Get a pad of paper to record coordinate locations during the calibration procedure. This
will help in zeroing in on a coordinate location.
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7. There are two parameters to adjust in the calibration for both x and y dimensions. The
OFFSET is the distance the image area is from the 0,0 position for the system's x,y axis.
Adjusting x and y offset moves the whole cutting area. This is defined in linear terms
with 100 offset units equal to 1 mm on the cutting platform.
PPX and PPY are adjustments to the distance between two points in the cutting area. If
the corners of the plate are too close or too far apart from each other to match the
calibration template, the ppx or ppy is adjusted accordingly. The digits in the ppx and
ppy do not relate to a linear dimension. Large movements of adjustment should be made
with changes to the digits in the 3rd place (0.00X). Fine adjustments are generally made
in the 4th place (0.000X). The process will require adjustments of the number value, and
then checking for the result by a single "cut" without cutting the template.
The following diagram is an example for explanation purposes of the calibration routine.
"Circles" are the positions that are selected on the SpotOn screen. Square spots show the
position that the spot is actually "cut". The square spots are adjusted during calibration to
"cut" the circles.

Circles indicate where the spot should be cut
Squares indicate the spot that is actually cut.
•

The squares need to be adjusted to the same position as the circles in the examples.

Y Pixel and Offset Calibration (Y Offset and PPY)
1. Select spot #1 (see diagram), and select to next MTP Well.
2. Hint: Take note of where the 1st spot "y pixel" coordinate is on the monitor. This can be
used to line up the 2nd spot y coordinate
Hint: To get a more accurately cut spot, click on the Enable Arrow Keys shortcut button
on the shortcut menu bar and use the arrow keys for fine cursor control.
3. Select spot #2 (see diagram).
4. Run the cutting run for spots #1 and 2.
Hint: Stop the cutting tip down on the calibration plate by clicking on any menu item as the
tip comes down. (Do not select any of the options.) This will freeze the system and will
provide a longer time to evaluate the location of the cutting tip.
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Check to see which of the following scenarios is closest to how yours appeared.
5. Select Calibration from the Operation Menu, then select Manual Calibration.
6. Enter the Serial Number. Change the number as indicated by the needed movement for
the cutting tip.

7.

Scenario 1:
(a)

The Y Offset needs to be increased.

(b)

Once spot #1 is parallel to the bottom line, check to see if spot #2 is parallel to the
top line. Increase or decrease PPY depending on whether the second spot is above
or below the top line.

(c)

Once spot #2 is parallel with the top line, check to see if spot #1 is still parallel to
the bottom line. It it is, go to the next step.

Scenario 2:
(a)

The PPY needs to be decreased.

(b)

Continue decreasing the PPY until it looks like Scenario 1.

(c)

Continue with Scenario 1

Scenario 3:
(a)

The PPY needs to be increased.

(b)

Continue increasing the PPY until spot #2 is approximately the same distance above
the top line as spot #1 is above the bottom line.

(c)

The Y Offset will then need to be decreased.
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X Pixel and Offset Calibration (X Offset and PPX)
1. Select spot #3" (see diagram), and select to next MTP well.
2. Run the cutting run with just spots #2 and 3.
3. Check to see which of the following figures is closest to how yours appeared.
4. Select Calibration from the Operation Menu, then select Manual Calibration.
5. Enter the Serial Number.

6. Scenario 1:
(a)

The X Offset needs to be increased.

(b)

Once spot #2 is parallel to the left hand line, check to see if spot #3 is parallel to the
right hand line. Increase or decrease PPX depending on whether the third spot is left
or right the right hand line.

(c)

Once spot #3 is parallel with the right hand line, check to see if spot #2 is still
parallel to the left hand line. If it is, go the "Adjustments" below.

Scenario 2:
(a)

The PPX needs to be decreased.

(b)

Continue decreasing the PPX until it looks roughly like Scenario 1.

(c)

Continue with Scenario 1

Scenario 3:
(a)

The PPX needs to be increased.

(b)

Continue increasing the PPX until spot #3 is approximately the same distance right
of the right hand line as spot #2 is right of the left hand line.

(c)

The X Offset will then need to be decreased.

Adjustments
Once the calibration has been completed, run the cutting run with all of the spots. If these
are all selected by the cutting tip in the right position, then select a 4th spot and run that. If
any changes are needed, adjust accordingly.
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Section 7
The Gel Cutting System Menu Bar
7.1 File Menu
Selecting the File menu will produce the following drop down menu.

Open Image File
Select this menu to open an image file, or click the Open Image File shortcut button located
below the menu bar. When the Open window is displayed, an image file can be selected by
doing the following:
(i)

Click on the file to be opened, then press the Open button to open the
file, or

(ii)

Double click on the file name displayed in the file list window.

To leave the Open window without selecting a file, simply click on the Cancel button.
Save Image File
Select this menu or click the Save Image File shortcut button located below the menu bar
to save changes to an image file. This will display the Save Image File window. Selecting the
Save In field of this window allows you to select the drive and directory into which you want
to save the picture file.
Selecting the File Name field of this window enables you to select a file name for new
files or change the file name of existing files. If you change the file name of any existing file
and save it, you will then have two copies of this image file, one with the new name and one
with the old name. However, if changes were made to the file before saving, they will only
be updated to the new file.
Once you have made your selection, you can either save by selecting the Save button or
cancel your selection with the Cancel button.
When the Save button is selected, the image file will be saved and a Save Project File
window will be displayed. This window is used to save the text details of the image file, i.e.
the project number, spot selected, spot destination, locations, etc. It is recommended that you
use the same file name as the image file.
To save the text file, press the Save button.
Photo Enhancer
The Photo Enhancer program is used for the operation of the Digital Camera.
This program is accessed from the SpotOn System Menu Bar. Either:
(i) Select the File menu, then select the Photo Enhancer menu from the drop
down menu, or
(ii) Press the Photo Enhancer shortcut button.
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This will produce an information box. Press the Yes button to move the cutting head to the
parking position and turn lights on if you wish to take a picture. Alternatively, select "No" and
use the pulse button on the front of the system to turn lights on. Next, another information box
will appear, press the OK button to continue. You should now be in the Photo Enhancer
program.
Print
Select this menu, or pressing the Print shortcut key located below the menu bar to print
an image file. The image must have a project number to be printed. If it does not, upon selecting
the Print menu an information box will appear stating "No project number, do you want to
enter new number?" Press Yes and enter a project number to proceed with printing.
Note: A Gel number is not needed to print.
The Name field of the Printer panel enables you to select a printer if more than one printer
is connected to your computer.
Selecting the Size list box of the Paper panel displays a drop down list from which you
can select the paper size to be used.
Selecting the Source list box of the Paper panel displays a drop down list from which
you can select either manual or auto sheet feed.
The Orientation panel allows you to select either Portrait or Landscape page orientation.
Once the above settings are completed, press OK. This will display the Print Selection
window.
This contains a number of options for printing:
(a) The Original Picture selection will print the picture as it was when the image
was last opened using Open Image file, i.e. no matter how many changes (new
spots) have been made, the original opened image will be printed.
(b) The Amended Picture selection prints the original image plus any amendments
made to it since the picture file has been opened. It will print all spots cut and
all spots selected, but not yet cut.
(c) By selecting the With Spots List check box, the Digital Camera x-y coordinates
for each spot are also given.
Once selections have been made, select the OK button to print picture, or Cancel if you
no longer wish to print.
Exit
Select the Exit menu to leave the SpotOn System program.

7.2 View Menu
Selecting the View menu will produce the following drop down menu.
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Zoom In
Selecting the Zoom In menu, zooms in on the picture displayed in the Zoom window at
the top right hand corner of the screen. This can also be achieved by pressing the Zoom In
short cut button located below the menu bar.
Zoom Out
Selecting the Zoom Out menu, zooms out on the picture displayed in the Zoom window
at the top right hand corner of the screen. This can also be achieved by pressing the Zoom Out
shortcut button located below the menu bar.
Display with Spot Number
By clicking on the Display with Spot Number menu, a check will appear next to it or
disappear depending on its current state. With a check present, any location on the image file
shown in the Zoom box will show a circle and spot number for selected spots in the Zoom box
window. Without the check present in the menu, no spot numbers will be shown in the Zoom
box.
Delete Spot
Selecting the Delete Spot menu produces the Delete Spot window. To delete a spot, click
on the spot number to be deleted in the larger text field. This spot number should now be
displayed in the smaller text field. The spot can now be deleted by pressing the OK button. If
you wish to leave the Delete Spot window without deleting a spot simply click the Cancel button.

7.3 Cutting Menu
Selecting the Cutting menu displays the following drop down menu.

Run
A cutting run can be selected by either:
(i) Selecting Run from the Cutting menu, or
(ii) Selecting the Run shortcut button located below the menu bar.
A window will come up confirming the sequence of spots to be cut. You may not wish
to cut all the spots selected during this cutting run. This can be achieved by putting the desired
starting spot number and last spot number in the Start from and To fields respectively of the
Set-up Cut Spot window.
Note: An individual run must consist of a sequential subset of the total spots selected, i.e.
you can not select to cut spots 4 & 6 on an individual run without spot 5 being cut. You also
can not have an individual run cutting spots out of order, i.e. 4, 6, 5 is invalid, would need to
be 4, 5, 6.
Once the spot sequence to be cut has been selected, press the OK button of the Setup Cut
Spot window. When cutting is complete, the Cutting Complete window will be displayed,
select OK to continue.
You may now either make more cuts and or spot selections, or exit the program.
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7.4 Operation Menu
Selecting the Operation menu displays the following drop down menu.

Project Number
Select this menu to change or add a new Project number and or Gel/PVDF number.
New Project
Select this menu to change or add a new Project number and or Gel/PVDF number.
Using this menu, any currently selected spots not yet cut will be lost.
Calibration
This function is used to calibrate the x, y movements of the cutting head Alternatively you may
select the Manual calibration shortcut buttons located below the menu bar (see Appendix D).
Upon selecting the calibration menu the Serial Number box will appear.
You must click on the Enter Serial Number text field and type in the serial Number.
(The serial number was provided when the system was delivered).
Light On/Light Off
Selecting this menu will either turn system lights on or off, depending on their current
state.
(a) Lights on can also be achieved by pressing the Light On shortcut button located
below the menu bar. (see Appendix D)
(b) Light off can also be achieved by pressing Light Off shortcut button located
below the menu bar. (see Appendix D)
(c) The lights may be turned on temporarily at any time by pushing and holding in
the lights on push button located at the front of the system. See Appendix A.
Move to Home
Select this menu or press the Move to Home Position shortcut button located below the
menu bar (see Appendix D) to move system cutting head to the home position. This is the
location at the top left-hand corner of the working surface. This position may be used for
changing cutting tips.
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Move to Park
Select this menu or press the Move to Park position shortcut button located below the
menu bar, (see Appendix D) to move the cutting head to the park position. This is located at
the top right hand corner of the working surface. The cutting head should be in the park
position before a picture is taken. On system initialization, the cutting head is automatically
moved to the park position.
Communication
Select this menu to change the set-up of the communication ports for data transfer between
computer and cutting system. The system will default select the COM 2 port. This can be
changed to the COM 1 port in the communication panel. This selection will only be held for
that set-up. The next time the system is turned on, it will default back to COM 2.
Others (Cutting Tip Control and Lights)
Selecting this menu produces the Other Function setup window. This contains several
alternative methods of cutting head operation. By trying these methods under varying
circumstances, you can work out which method will work best for your needs and under
certain conditions.
The standard operation (nothing selected in Others) will direct cutting tip rotation as the
spot is being cut. The cutting head ceases rotation before the spot is dispensed, the spot is
then dispensed to the MTP well while the cutting head is down.
Recommendations:
Acrylamide Gels:
PVDF Membrane:
Calibration:

Use standard (default) method. For increased assurance of positive eject,
select Double Eject.
Use Eject With Turn in order to help eject the static membrane from
the stainless steel tip.
Use Cut without Turn in order to keep the cutting tip from marking the
template.

The difference between each of the six alternative methods from the standard method
normally used by the system are the following:
(a) Double Eject–same as standard operation except there is a double movement
of the eject pin.
(b) Eject With Turn–same as standard operation except the cutting tip is rotating
during ejecting.
(c) Eject with Cutting Head Up–same as standard operation except the cutting
head does not move down while ejecting.
(d) Lights Select Enabled/Disabled–allow the lights on/off shortcut buttons to be
enabled or disabled.
(e) Cut Longer–cutting tip will stay down longer on the cutting surface.
(f) Cut without Turn -same as standard operation except the cutting tip does not
rotate during the cut.
Note: Combinations of the above may be tried by the operator to suit different conditions.
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7.5 Window Menu
Selecting the Window menu displays the following drop down menu.

Spot Location
Selecting this menu produces the Spot Location window. For each selected spot, this
window displays:
(i) The camera image x, y location coordinates.
(ii) The MTP (microtiter plate well destination position).
(iii) The current state of the spot, i.e. selected, cut or deleted.
The current state of a spot may be changed inside this window
Right clicking in the Current State column for the corresponding row of the spot number you wish to amend, will produce a pop-up menu from which you may select the desired
changed required. This may be used to implement the following;
(i) Delete a selected spot.
(ii) Select a cancelled or deleted spot.
(iii) Reselect a cut spot to enable recutting.
Use the scroll bar to move up and down the list of spots, and then select a spot by clicking on the desired field.
To print the details of this window, press Print.
To leave this window, select the OK button.
MTP Data
Selecting this menu produces the Microtiter Plate (MTP) Location window. This
window lists all MTP locations vertically. Each individual location has a row with space
provided for up to 10 spots to be allocated to it. Any spot number assigned to a given MTP
location will be given in the row of that location.
The scroll bar may be used to move within the list.
To print this screen, click the Print button.
To leave this window, select the OK button.
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7.6 Help
Selecting the Help menu displays the following drop down menu.

This menu provides documented help topics and information about the system.

Section 8
Maintenance
8.1 General Upkeep and Cleaning
When the System is not in operation, use the dust cover supplied with the System. This
will reduce the amount of dust and keratin that collects on the cutting surface.
For general cleaning of the system, wipe with a damp cloth. Ethanol or mild detergents
may be used. Do not use any harsh solvents or cleaners.

8.2 Cutting Surface Lights
Location of Lights
The cutting surface lights are located directly beneath the cutting surface and consist of
four 9W low temperature (4100 K) fluorescent tubes.
Replacing Surface Lights
Please see Appendix B when changing fluorescent tubes. The lighting front cover must
be removed first by removing the two front cover screws. Once the cover has been removed,
the required fluorescent tube(s) may be gently pulled out and then replaced by pushing the
replacement tubes into position. After the tube(s) have been changed the front cover is
reattached.

8.3 Fuses
The main power fuse is located on the system box interface plate, refer to Appendix C for
exact location. At delivery, thre is no voltage fuse installed. Verify regional voltage input and
select the appropriate fuse and voltage setting. The fuse for 240 VAC operation is the 1.6A
fuse. For 120 VAC operation a 3.15A fuse is used. Two of each of these fuses have been
supplied with the System. Bio-Rad Sales and Service will make arrangements in the purchase
agreement to install the System and set the correct voltage and fuse configuration.
The camera power fuse is located on the system box interface plate, refer to Appendix C
for exact location. The fuse is a 2.5A fuse. One spare fuse has been supplied with the System.
Note: All other fuses are located internally in the system box. Service assistance should be
obtained if these fuses need replacing.

22

8.4 Cutting Tips
Cutting Tip Cleaning
The cutting tip is made of high quality 303/304 stainless steel. It will retain its cutting
ability through repeated use and should not need to be replaced even after 6 months of use.
If the tip is not picking up gel pieces as efficiently as earlier runs, there may be gel material
building up inside the tip. Either clean out the tip with water or alcohol and a wire, or replace
the cutting tip with a new one. Daily maintenance includes washing the cutting tip with water
or alcohol. Take the tip off the instrument and squirt water or alcohol through the tip. To
remove the cutting tip, see the following section on "Changing Cutting Tips".
Ejection Pin
If the ejection pin is not recovering after pushing out through the cutting tip, a small
amount of lubricant may be used in the mechanism. Take the cylindrical cutting assembly
cap off and spray or drop silicon lubricant (like WD40) down the shaft of the ejection pin
(where the spring is). Manually work the mechanism by pushing down on the top of the
ejection pin. It may also help to take the cutting tip off and clean it out with the alcohol and
wire method recommended above.
Changing Cutting Tips
To change a cutting tip, move the cutting head to the home position. This can be done by,
pressing the Move to Home Position shortcut button located on the menu bar. Once in the
home position, use the two wrenches (spanners) supplied with the system. The customized
wrench (spanner) is used to hold the cutting tip holder by fitting into the grooves located on
the cutting tip holder. The 6mm open ended wrench (spanner) will then fit the top of the
cutting tip. Turn the wrench (spanner) counter-clockwise to remove the tip. A new tip can
then be inserted and turned clockwise to install. Use the same wrenchs (spanners) to tighten
the cutting tip. This does not have to be over-tightened, but snug.
Note: the top of the cutting tip is rectangular in shape. If the 6 mm wrench (spanner) does
not appear to fit you will need to rotate the cutting tip 90° and then the wrench (spanner)
should fit.
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Adjusting Cutting Tip Height
1. Remove the spindle cover.
2. Loosen the spindle hexagonal screw as indicted in diagram 1.
3. Adjust the height by moving the shaft up or down as required.
4. Tighten the screw after adjusted.
If the cutting tip is not making contact with the cutting surface, the cutting tip needs to be
lowered. If cutting results in the cutting surface being indented, the cutting tip needs to be
raised.

1.

2.

If the shaft will not go any further but the cutting tip still needs to be raised, the carriage needs to
adjusted. Use the following procedure to adjust the cutting carriage.

Adjusting the Cutting Carriage
1. Remove the spindle belt in diagram 2 (previous).
2. Unscrew the ground cable connecting the cutting head to the mounting plate.
3. Remove the spindle cutting assembly by removing the two mounting screws. See
diagram 3.
4. Undo the two hexagonal screws holding the carriage cover, remove cover See diagram 3.
5. Loosen the 4 screws fixing the carriage. See diagram 4.
6. Adjust the height as required.
7. Tighten the 4 screws.
8. Place the carriage cover back into position.
9. Mount the cutting assembly using the two screws.
10. Replace the grounding cable, belt, and spindle cover.

3.

4.
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8.5 Camera Cover Cap
The camera cover cap is attached to the camera cover by a single hinge. There is a screw
located at the center of this hinge which can be tightened or loosened to adjust the tightness
of the cap. The system will be delivered with the screw tightened so that the cover cap will
remain in place during transportation. If you need to lift the cap to obtain access to the
camera, you will need to loosen this screw first.

8.6 Technical Service
For technical assistance with the system including all hardware and software, contact
your local Bio-Rad office, or in the US call 1-800-424-6723. All spare parts not listed in this
document can be ordered by contacting your local Bio-Rad office.
For inquiries and requests regarding system repair or service, contact your local Bio-Rad
office or distributor (in the U.S., call Technical Service at 1-800-424-6723). Please have the
following details available:
1. Instrument model and catalog number.
2. Serial number (located on the back of the system).
3. Hardware and software version information.

8.7 PROTEAN 2-D Spot Cutter Warranty Information
This warranty statement may vary outside of the continental United States. Please contact
your local Bio-Rad office for the exact terms of your warranty.
Bio-Rad Laboratories warrants to the customer that the PROTEAN 2-D Spot Cuter
system (catalog number 165-7005) will be free from defects in material and workmanship
and will meet all of the performance specifications for a period of one year from the date of
shipment. This warranty covers all parts and components of the instrument except those such
as gaskets, o-rings, batteries, and other items of normal wear that require frequent replacement.
This warranty does not cover items broken or damaged, including glass or platinum
electrodes, by improper handling or use.
If any defects should occur during this period, Bio-Rad Laboratories will either replace
or repair the defective parts free of charge. For the exact terms of warranty, please see the
Instrument Warranty Card.
In the event that the system must be returned to the factory for repair under warranty, the
instrument must be packed and returned in its original shipping container. If this is not
available, contact Bio-Rad Technical Service for instructions.
Bio-Rad shall not be liable for any incidental, special or consequential loss, damage or
expense, directly or indirectly arising from use of the PROTEAN 2-D Spot Cutter system.
Bio-Rad makes no warranty whatsoever in regard to products or parts furnished by third
parties, such being subject to the warranty of their respective manufacturers. Service under this
warranty shall be requested by contacting your nearest Bio-Rad office.
This warranty does not extend to any instruments or parts thereof that have been subject
to misuse, neglect, or accident, or that have been modified or serviced by anyone other than
Bio-Rad or its representative, or that have been used in violation of Bio-Rad instructions. It
also does not extend to instruments or parts thereof that have been used with fittings or other
spare parts not authorized by Bio-Rad Laboratories, that are interfaced to inappropriate
external devices, that have been exposed to inappropriate solvents, cleaning agents or samples.
The warranty also does not cover instrument damage resulting from facility problems such as
power surges.
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The foregoing obligations are in lieu of all other obligations and liabilities including negligence and all warranties of merchantability, fitness for a particular purpose otherwise
expressed or implied in fact or by law, and state Bio-Rad's entire and exclusive liability and
buyers exclusive remedy for any claims or damages in connection with the furnishing of
goods or parts, their design, suitability for use installation and operation. Bio-Rad Laboratories
will in no event be liable for any special, incidental or consequential damages whatsoever, and
Bio-Rad's liability under no circumstances will exceed the contract price for the goods for
which liability is claimed.
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Appendix A
System Box (Front)
4

5

3

1

2

7

8

1. Camera Cover Cap
2. Camera Cover
3. Camera Mounting Screw
4. Camera Communications Cable Plug
5. Camera power cable Plug
6. X-Y Movement Bar
7. Start/Pause Button
8. On/Off Switch
9. Light Push Button
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Appendix B
Working Surface
2

3

10

4

6

1

9

5

8

1. Cutting Mechanism Cover
2. Cutting Tip
3. Cutting Tip Holder
4. Cutting Head Shaft Cover
5. Bubble Level
6. Cutting Surface
7. Microtiter Plate Well
8. Microtiter Plate Positioning Pin
9. Light Front Cover Panel
10. Front Cover Panel Screws
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Appendix C
System Box (Back)

1

2

3

4

5

6

1. Voltage Selector
2. Main Power Plug
3. Fuse for Voltage Settings
4. System Communication Port
5. Camera Power Plug
6. Camera Communications Port
7. Camera Mounting Arm
8. Ground Plug

29

7

8

Appendix D
The Shortcut Button Menu Bar
The following figure shows the Shortcut Button Menu Bar.

1

2

3

4

5

6

7

8

9

10

11

12

13

14 15

16

Button 1 is the Open Image File shortcut button.
Button 2 is the Save Image File shortcut button
Button 3 is the Print shortcut button
Button 4 is the Zoom In shortcut button.
Button 5 is the Zoom Out shortcut button.
Button 6 is the Stop Process button. This button may be pressed at any time during a cutting
run to stop the run.
Button 7 is the Run shortcut button.
Button 8 is the Pause button. This button may be pressed at any time during a cutting run to
pause that run. Once a run has been paused to recommence, press the pause button once.
Button 9 is the calibration shortcut button.
Button 10 is not active in this version of the software.
Button 11 is the Light On shortcut button.
Button 12 is the Light Off shortcut button.
Button 13 is the Move to Park Position shortcut button.
Button 14 is the Move to Home Position shortcut button.
Button 15 is the Enable Arrow Keys shortcut button.
Button 16 is the Photo Enhancer shortcut button.
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Glossary
Box

Refers to a dialog box. This is a box (window) which pops up
onto the screen containing dialog to be read, and then requires a
button to be pressed, e.g. "OK" or "Yes" to progress any further
in the program.

Click

Unless otherwise specified, this refers to a single left button mouse
click on the desired menu or item.

Drop Down
List

Is a list of selections that appear below a list box when the list
box is selected.

Drop Down Menu

Refers to a list of menus which appear below a specific menu
when it has been selected.

Folder

When there is more than one screen that can be selected inside
of a window, each screen is called a folder. Each folder contains
different data concerned with the window's specific function.

List Box

A list box is a text field which contains a drop down list from
which a selection can be made.

Panel

A panel is a segment inside a window or folder containing specific
information. It usually contains at least one text field or list box.

Press

Unless otherwise specified, this refers to a single left button mouse
click on the desired menu or item.

Select

Unless otherwise specified, this refers to a single left button mouse
click on the desired menu or item.

Spot

A spot is a position within the image which has been selected to
be cut.

Text Field

Is an area into which text can be entered.

Window

Is either (i)

Similar to a box (dialog box) except it contains text fields
and folders which can be manipulated, or

(ii) A view window which contains a picture.
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System Records

Serial Number

________________________________

Date of Purchase

_____________________________

Purchase Order
Number

_____________________________

Notes
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
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Service Record
Date

Description of Problem

Name
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